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Mast cells are specialized, tissue resident, immune effector cells able to respond to a wide
range of stimuli. MCs are involved in the regulation of a variety of physiological functions,
including vasodilation, angiogenesis and pathogen elimination. In addition, MCs recruit and
regulate the functions of many immune cells such as dendritic cells, macrophages, T cells,
B cells and eosinophils through their selective production of multiple cytokines and
chemokines. MCs generate and release multi-potent molecules, such as histamine,
proteases, prostanoids, leukotrienes, heparin, and many cytokines, chemokines, and
growth factors through both degranulation dependent and independent pathways. Recent
studies suggested that metabolic shifts dictate the activation and granule content
secretion by MCs, however the metabolic signaling promoting these events is at its
infancy. Lipid metabolism is recognized as a pivotal immunometabolic regulator during
immune cell activation. Peroxisomes are organelles found across all eukaryotes, with a
pivotal role in lipid metabolism and the detoxification of reactive oxygen species.
Peroxisomes are one of the emerging axes in immunometabolism. Here we identified
the peroxisome as an essential player in MCs activation. We determined that lack of
functional peroxisomes in murine MCs causes a significant reduction of interleukin-6,
Tumor necrosis factor and InterleukinL-13 following immunoglobulin IgE-mediated and Toll
like receptor 2 and 4 activation compared to the Wild type (WT) BMMCs. We linked these
defects in cytokine release to defects in free fatty acids homeostasis. In conclusion, our
study identified the importance of peroxisomal fatty acids homeostasis in regulating mast
cell-mediated immune functions.
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INTRODUCTION

Mast cells (MCs) are highly specialized cells able to respond to a large panel of stimuli (Theoharides
et al., 2019). MCs are characterized by highly metachromatic granules with potential for different
routes of release (Wernersson and Pejler, 2014; Jain et al., 2019). MCs can respond rapidly to stimuli
by releasing granules containing antimicrobial cytotoxic mediators such as serine protease,
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histamines, proteoglycans and lysosomal enzymes or performing
de novo synthesis independent of degranulation of reactive
oxygen species (RO) and cytokines (Moon et al., 2014). MCs
are also endowed with complex lipid droplets (Dichlberger et al.,
2013) making them an important source of various lipid
mediators (eicosanoids) such as leukotrienes and
prostaglandins which are important players in immune cell
activation and recruitment (Boyce, 2005). In addition to lipid
production, MCs have been shown to respond to lipid mediator
stimulation (Abdel-Majid and Marshall, 2004; Wang and Kulka,
2015; Hagemann et al., 2019).

Changes in metabolism have recently been identified as a
mechanism that supports MCs activation such as IgE mediated
degranulation (Mendoza et al., 2021). Several studies have shown
the importance of lipid metabolism in MCs that goes beyond the
production of lipid mediators. In fact, high-fat diet or chronic
insulin exposure led to a lipid accumulation and altered
degranulation in MCs (Greineisen et al., 2015; Aldan et al.,
2019). However, how lipid metabolism supports MCs
activation and regulates their distinct activities such as
degranulation and/or cytokine release is largely unexplored
and represents an important area of investigation to unravel
how these essential innate immune cells are regulated.

Peroxisomes are specialised organelles for metabolism found
across all eukaryotes. Peroxisomes have a pivotal role in lipid
metabolism and in detoxification of ROS and reactive nitrogen
species. They also contribute to the metabolism of polyamines,
carbohydrates and amino acids (Wanders and Waterham, 2006;
Fransen et al., 2012; Smith and Aitchison, 2013; Liu et al., 2019).
There is substantial evidence that peroxisomes actively contribute
to cell signaling and that their function is required for human
health (Beach et al., 2012; Braverman et al., 2013; Braverman
et al., 2013; Fransen et al., 2013; Trompier et al., 2014; Colasante
et al., 2015). Recent evidence corroborated a role for peroxisomes
inmodulating immune responses (Dixit et al., 2010; Di Cara et al.,
2017; Di Cara, 2020). Indeed, peroxisomes were first described to
have an important role during viral infections serving as signal
platforms for mitochondrial antiviral signaling (MAVS) proteins
and induction of interferon responses (Sychev et al., 2017; Xu
et al., 2017; Cook et al., 2019; Merkling et al., 2019). In recent
years, substantial evidence has shown the importance of
peroxisome metabolism in macrophage activation and
phagocytosis (Boncompain et al., 2014; Di Cara et al., 2017;
Eguchi et al., 1979; Vijayan et al., 2017). Further studies
showed the importance of peroxisome-derived ether lipids in
natural killer T (NKT) cell thymic development (Brutkiewicz and
Dent, 2012; Facciotti et al., 2012). Thus, peroxisomes contribute
to drive signaling pathways in innate and adaptive immune
responses through metabolites such as ROS and lipids such as
fatty acids. The metabolism of fatty acids (FAs) is a major source
of biological lipids that form cell membranes and regulate
inflammatory processes (Puertollano et al., 2001; Sadik and
Luster, 2012; Dowds et al., 2014; Hubler and Kennedy, 2016).
FAs are precursors to phospholipids (PLs), sphingolipids (SLs),
triglycerides (TAGs) and eicosanoids, which have critical roles in
the activation and function of macrophages, invariant NKT cells
(Lim et al., 2003; Miao et al., 2014; Bettencourt and Powell, 2017).

Likewise, the PL precursor, phosphatidic acid (PA), regulates the
mammalian target of rapamycin (TORC1)-dependent
production of pro-inflammatory cytokines in macrophages
(Lim et al., 2003).

MCs are essential innate immune cells. Beyond their
activities in allergic disease, MCs play a crucial role in host
defense (Marshall, 2004; Abraham and St John, 2010) and
cancer immunity (Oldford et al., 2010; Komi and Redegeld,
2020; Hanes et al., 2021). Mast cell degranulation
mechanisms are well studied but much less is known about
how lipid metabolism regulates MCs functions. Here we
determined the requirement for peroxisomes in regulating
distinct immune functions in MCs. We probed the need for
functional peroxisomes in mounting Toll like receptor(TLR)2
and 4, IgE-mediated activation of Bone marrow-derived mast
cells (BMMCs) extracted from wildtype (WT) mice and mice
carrying a global mutation for Peroxin2, a gene that encodes
for an ubiquitin ligase essential for the biogenesis of
peroxisomes in cells and therefore its mutation leads to
cells with not functional peroxisomes (Faust and Hatten,
1997; Smith and Aitchison, 2013). Our work demonstrated
a role for peroxisomes in modulating cellular free fatty acids
(FFAs) to regulate TLR and IgE-dependent secretion of
cytokines in MCs. In stimulated WT MCs, peroxisome
number increases, contributes to cellular FFAs homeostasis
and support cytokines release. Of note, peroxisomes appeared
dispensable for IgE-mediated degranulation. Taken together
our report provides evidence of a requirement for peroxisome
to control cellular lipid metabolism for distinct MC immune
functions. Defining the role of peroxisomal metabolism in
MCs may uncover new avenues of treatment for immune
disorders and requires greater insight into the function
of specific metabolic pathways involved in immune
responses.

METHODS

Pex2 Mutant Mice
The Pex2 Mutant Mouse Strain used was 129S6.129-Pex2tm1Plf/
Mmmh(Null allele) (Faust andHatten, 1997) andwas obtained from
the Mutant Mouse Resource and Research Centre (MMRRC)
supported by the NIH. The mice used for this experiment were
Pex2+/+, Pex2−/−, Pex2+/−. Homozygous null mutant strains showed
no Pex2 transcript and protein. Homozygous mutants in this
congenic strain show variable embryonic lethality, starting at
~E11. Approximately 20% of homozygotes survive to birth but
are hypotonic, do not feed and die on the day of birth. Homozygous
mutants that survive in the postnatal period are obtained by mating
congenic 129S6.129-Pex2tm1Plf +/- mice with wild-type Swiss
Webster strain mice. F1-Pxmp3tm1Plf+/- hybrids (designated
Sw129) are then intercrossed to obtain Sw129-Pxmp3tm1Plf−/−
(indicated in the text as Pex2−/−) mice.

Colonies were maintained as stable inbred lines in the Swiss
Webster and 129SVEV background under approved animal
protocol 21-023, abiding by the standards of the Canadian
Council on Animal Care.
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Mast Cell Culture
BMMCs were generated from SWR/J and Pex2−/−mice according
to the method of (Tertian et al., 1981). After at least 4 weeks of
culture, the purity of mast cells was evaluated based on the
expression of the high-affinity IgE receptor, also known as
FcεRI and tyrosine-protein kinase cKIT (Cluster of
differentiation, CD117). Cells were used at >98% of purity and
consistently contained metachromatic granules.

Polymerase Chain Reaction
Total RNA was extracted using the RNeasy Plus Mini Kit
(Qiagen, Mississauga, Canada). Genomic DNA was depleted,
and complementary DNA was amplified using the Platinum
Taq Reverse Transcription Kit (Wisent). Pex2 gene was
amplified using HiFi Platinum Taq DNA kit (Thermofisher)
and the following primers forward (5′-TGAAGGAACCAC
TTAGAAATTACAGA) and reverse (5′-CCAGGGCCTTAT
TCAGTTCA). Samples were loaded onto a 2.5% agarose gel
(with ethidium bromide) in TAE and imaged using chemiDoc
imaging system (Biorad).

Toluidine Blue Staining
Cytospins of mast cells were briefly fixed in Carnoy’s fixative then
rinsed in water and 0.033N HCl. Cells were then stained with
Toluidine blue (pH 0.3) overnight then rinsed before drying and
mounting in DPX (Sigma) for imaging with Mantra 2TM at ×40
magnification.

Degranulation Assessment
BMMCs (2 × 106/ml) in modified HEPES-Tyrode’s buffer were
treated for 15 min with increasing doses of TNP-BSA
(Trinitrophenyated-Bovine serum albumin) (Bioresearch
Technologies) or calcium ionophore A23187 (Sigma) as a
positive control. The level of degranulation was assessed via β-
hexosaminidase release according to the method of Schwartz et al.
(Schwartz et al., 1979). The percentage of β-hexosaminidase
release was calculated as follow:

% of release � {(O.D supernatant − O.D control) ÷ [

× (O.D supernatant − O.D control)

+ (O.Dpellet − O.D control)]}X100

Mast Cell TLR and IgE Activation
Prior to all activations, BMMC were ‘‘rested’’ overnight in
modified mast cell growth medium, with 3 ng/ml mIL-3
(Peprotech) or without PGE2 (Tocris). For analysis of cytokine
production, cells were washed twice and resuspended in medium
consisting of RPMI 1640 with 1% FBS, 15 mM HEPES and 3 ng/
ml rmIL-3 and 100 μg/ml of soybean trypsin inhibitor. For all
activations, cells at 1 × 106/ml were incubated with Pam3-CSK4-
KKKK (L2000, EMCmicrocollection) at 50 μg/ml or LPS (Sigma)
at 50 μg/ml and A23187 (Sigma) at 0.5 µM for 24 h at 37°C. For
IgE activation, BMMCs were sensitized with anti-TNP
(Trinitrophenol phosphate) IgE overnight. Cells were then
rinsed and treated with 10 ng/ml of TNP-BSA for 30 min,
then supernatants were removed, and cells were cultured for a

further 24 h. For mechanistic studies, cells were treated with
100 μg/ml of niacin (Sigma Aldrich) for 48 h or with 2.5 uM
thioridazine for 1 h prior to IgE activation. Supernatants were
removed, and cells were cultured for a further 24 h. Cell-free
supernatants were collected and assayed for IL-6 (Peprotech), IL-
13 (Peprotech) and TNF (Invitrogen) by ELISA from sources
indicated.

Free Fatty Acid Assessment
One million BMMCs per genotype and under each condition was
sensitized with anti-TNP as described above and treated with
10 ng/ml of TNP-BSA for 24 h. Supernatants were removed, and
cells were analyzed for fatty acid accumulation using free fatty
acid quantification kit (Sigma) according to manufacturer’s
recommendations.

ELISA: Levels of IL-6 (Peprotech), IL-13 (Peprotech) and TNF
(Invitrogen) in supernatants were assessed according to the
manufacturer recommendations.

Fluorescence Microscopy
Cells were fixed in 4% paraformaldehyde in PBS for 30 min and
then incubated for 1 h at room temperature in 5% normal goat
serum (Sigma) and for 16 h at 4°C with primary antibody at 1:100
dilution in 5% normal goat serum. Appropriate Alexa Fluor
secondary antibodies (anti-rabbit secondary antibodies, were
from Abcam) were then used at 1:1000 dilution in 5% normal
goat serum. After 4 washes in PBST (PBS +0.1% (v/v) Triton X-
100), cells were mounted in DAPI Pro-Gold Antifade Reagent
(Thermo Fisher) and imaged using a ×100 oil immersion
objective (NA = 1.4) mounted on an Zeiss800 confocal
microscope (Zeiss) or using a Zeiss AxioObserver LSM 880,
100 × 1.4 oil plan-Apochromat lens. Primary antibody was
rabbit anti-SKL antibody was previously described (Szilard
et al., 1995).

Flow cytometry: Maturation of Pex2−/− and WT BMMC were
assessed by flow cytometry. Antibodies to CD117 (Clone 2B8,
Biolegend), FceR1(Clone MAR-1, Invitrogen) were used to assess
the maturation of BMMC cells. Fc receptors were first blocked
with anti CD16/CD32 (Clone 93, eBisocience) for 10 min.
Combinations of the two anti-CD117 and anti-FceR1
fluorescently tagged antibodies (at manufacturers
recommended dilutions) were added to each sample for
30 min at 4°C. For assessment of IgE binding, BMMCs were
sensitized with anti-TNP (Trinitrophenol phosphate) IgE
overnight. Cells were then rinsed then stained with
fluorescently tagged anti-IgE antibody (ClonePME-1,
Biolegend) or with isotype control rat IgG2b (Clone G0114F7,
Biolegend) for 30 min at 4°C.

After stainings, cells were washed twice with PBS
supplemented with 2% Fetal Calf Serum (FCS) (Gibco) then
fixed with PBS containing 1% paraformaldehyde for 30 min 4°C
before analysis on BD FACSCelesta™ (BD). Data were analyzed
using FlowJo Version 10 software (BD).

Viability Assay
BMMCs were resuspended at a density of 1million cells per mL in
activating media and seeded into a 24-well plate. BMMCs were
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stimulated in duplicates with either activation media, LPS (50 μg/
ml), Pam3CSK4 (50 μg/ml), or thiorizi dine (2.5 uM) for 24 h.
BMMCs were then washed in PBS prior to staining with fixable
viability dye Efluor 450 for 20 min at 4°C then rinsed before
fixation in 1% paraformaldehyde, and acquired on the FACS
Canto II flow cytometer. Data were analyzed using FlowJo
Version 10 software (BD).

Quantification and Statistical Analysis
Statistical analyses were performed using a non-parametric t-test
comparing between Pex2−/− and WT BMMCs. *p < 0.05, **p <
0.001, ***p < 0.0001 ns: not significant. All results are represented
as themean of at least 3 independent experiment ± Standard error
of the mean.

Quantification of SKL-Puncta
Average number of puncta per cell were calculated using ImageJ
software, applying the following steps to each image:

1—We opened stacks image.

File -> Open. . .

2—We filtered to remove noise.

Process -> Filters -> Gaussian Blur. . .

3—We subtracted background.

Process -> Subtract Background. . .
(the box marked “Light Background” was unticked).

4—We clicked on “Image”

Color -> Split the channels . . .
In this step, brightness and contrast were adjusted, and setting

were applied to all stacks.

5—We performed threshold image.

Image -> Adjust -> Threshold. . .
(We selected: Apply it to all stacks).
Box labeled “Dark Background” was ticked. We adjusted the

sliders so that features were red colored, but the rest of the image
was not. Then we clicked “Apply” button. This replaced grayscale
image with an “8-bit binary image.” All “red” pixels were
converted to a value of “255,” while all non-red pixels were
given a value of “0.”

6—We filled in any holes in the nuclei.

Process -> Binary -> Fill Holes

7—We separated “Touching” puncta.

Process -> Binary -> Watershed.
Process -> Find Edges.

8—We performed the analysis.

Analyze -> Analyze Particles. . .
In this dialog box the algorithm started to include or exclude

puncta based on their attributes. “Size” smaller than 0.1 mm and
larger than 1 mm “Circularity” set range: 200-1.

RESULTS

Lack of Functional Peroxisomes Does Not
Alter Mast Cell Morphology or
Degranulation But Reduces Cytokine
Release
To study the requirement of peroxisomes for MCs function, we
assayed BMMCs from wildtype and Peroxin2 null mutant mice
(Pex2−/−) (Supplementray Figure S1A) (Faust and Hatten,
1997). We confirmed the presence of peroxisomes by
performing indirect immunofluorescence (IF) using an
antibody against the C-terminal Peroxisome Targeting
Sequence Type 1 Ser-Lys-Leu (SKL), the canonical marker for
peroxisomal matrix proteins (Szilard et al., 1995).

WT MCs showed SKL-positive puncta while intense diffuse
staining was observed in Pex2−/−MCs confirming that the MCs
from Pex2 mutant mouse do not form functional peroxisomes
due to defects in peroxisomal protein import into the matrix
(Smith and Aitchison, 2013) (Figures 1A,B, Supplementary
Figure S1A; Supplementary Data Sheet S1, S2). Assessment
of maturation based on the expression of FceR1 and CD117 by
flow cytometry showed no differences between the two cell
types (Supplementary Figure S1B). Pex2−/− BMMCs
exhibited a similar morphology and granularity compared
to the WT BMMCs (Supplementary Figure S1C). All
together these observations indicated that absence of
peroxisomes did not alter maturation, morphology, or
granule content of MCs.

Through IgE-mediated degranulation, MCs hold a key role in
allergic disease and host defence against several parasites.
Peroxisomes are known to proliferate and increase during
responses to viral infection (Cook et al., 2019; Knoblach et al.,
2021). To assess the role of IgE-mediated activation and
peroxisomes we measured peroxisome numbers in WT
BMMCs when stimulated with IgE. Indirect IF followed by
automated quantification showed an increase in SKL-positive
puncta in stimulated MCs (Figures 1C,D, Supplementary Data
Sheet S3, S4) indicating that an increase in cellular peroxisomes
occurs during the IgE mediated MC response. We next assessed
whether an absence of peroxisomes altered IgE/antigen-induced
degranulation, assessed via a β-hexosaminidase release.
Peroxisome biogenesis defects caused by mutations in Pex2
have been linked to lipid metabolic defects (Faust and Hatten,
1997; Faust, 2003) thus, affecting the lipid milieu of the cell
membrane (Schrader et al., 2020). In fact, an altered membrane
lipids environment was reported to compromise signaling (Lodhi
et al., 2015) in multiple cell types including immune cells (Lodhi
et al., 2015; Di Cara et al., 2019). Thus, we first assessed the ability
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of WT and Pex2−/− BMMCs to bind IgE by flow cytometry. WT
and Pex2−/− BMMCs demonstrated equivalent IgE binding
(Figure 1E and Supplementary Figure S1D). Next, BMMCs
were loaded with Anti-TNP IgE overnight then crosslinked with a
dose range of TNP-BSA antigen or treated with calcium
ionophore A23187 allowing degranulation for 15 min. Pex2−/−

BMMCs displayed similar degranulation potential compared to
their WT counterparts (Figure 1F). When treated with calcium
ionophore A23187, Pex2−/− BMMCs demonstrated a higher
percent degranulation at lower A23187 doses (Figure 1G).
Overall, lack of functional peroxisomes did not adversely affect
mast cell degranulation.

Peroxisome Supports Cytokine Release
Upon TLRs and IgE Activation in Mast Cells
It is well established that MCs have degranulation-
independent pathways which allow the production of
cytokines and chemokines independent of classical
degranulation (Leal-Berumen et al., 1994; Moon et al.,
2014). Beyond their role in allergy, MCs are key player in
responses to pathogens (Marshall, 2004; Abraham and St John,

2010). MCs express and respond via Toll like receptors (TLRs)
to several bacterial or viral products (McCurdy et al., 2003;
Agier et al., 2018). We thus asked whether peroxisome
function is necessary for cytokine release upon TLR2 or
TLR4 stimulation induced by Pam3CSK4 (Pam3) and E.coli
lipopolysaccharide (LPS) respectively. We assessed whether
the lack of functional peroxisomes affected TLR and IgE-
mediated interleukin 6 (IL-6), interleukin 13 (IL-13) and
Tumor Necrosis Factor (TNF) production after 24 h
stimulation. Our data showed that IL-6 (Figure 2A) and IL-
13 (Figure 2B) were produced in response to TLR2 and TLR4
stimulation in WT BMMCs but production of both cytokines
was significantly reduced in Pex2−/− cells. On the other hand,
TNF production was significantly reduced only upon LPS
treatment in Pex2−/− compared to WT MCs (Figure 2C).
Interestingly, while IgE-mediated degranulation was not
affected by the absence of functional peroxisomes, cytokine
production was markedly reduced in Pex2−/− BMMCs upon
IgE stimulation followed by TNP-BSA treatment (Figures
2D–F). Additionally, IL-13 secretion was lower in Pex2−/−

BMMCs after IgE stimulation followed by treatment with
both TNP-BSA or with the calcium ionophore A231287

FIGURE 1 | Peroxisome do not alter MCs granularity and degranulation: (A)WT and Pex2−/− BMMCs were stained for peroxisome (SKL, Green) and nuclei (Dapi,
Blue). Scale bar, 10 µm. (B) Peroxisomes number was defined by automated counting of SKL-positive puncta per region of interest (ROI). The graph bars represent the
number of SKL-positive puncta in stack z = 3. N = 25 cells. For each cell 22 stacks were acquired. (C) Indirect immunofluorescence of WT and Pex2−/− BMMCs were
stained for peroxisome (SKL, Green) and nuclei (Dapi, Blue). Scale bar, 10 µm. (D) Peroxisomes number was defined by automated counting of SKL-positive
puncta. The graph bars represent the number of SKL-positive puncta in stack z = 3. The graph bars represent the number of SKL-positive puncta in stack z = 3. N = 25
cells. For each cell 22 stacks were acquired. (E) WT and Pex2−/− BMMCs were tested for their ability to bind to the anti-TNP specific IgE by flow cytometry. (F)
Percentage of beta -h exosaminidase degranulation was assessed upon 15 min of TNP-BSA IgE-mediated degranulation and (G) A23187 calcium ionophore-mediated
degranulation. Graphs represent the average of three independent experiments ±SEM. Statistical analyses were performed using a non-parametric t-test comparing
between Pex2−/− and WT BMMCs. **p < 0.01, ns: not significant.
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(Figure 2E). We tested the secretion of other cytokines such as
interleukin 5 (IL-5), Granulocyte-macrophage colony-
stimulating factor (GM-CSF) and Chemokine (C-C motif)
ligand 3 (CCL3) (Supplementary Figure S2A–C). A23187
selectively induced CCL3 production which was
significantly decreased in Pex2−/− compared to the WT
BMMCs (Supplementary Figure S2C). All together these
results indicated a requirement for peroxisomes in MCs
activation in response to IgE-mediated, TLR2 or TLR4
stimulation.

Peroxisome Regulates Free Fatty Acid
Metabolism During MCs Activation
Peroxisomes are highly conserved organelles and play a pivotal role
in lipid metabolism and ROS such as hydrogen peroxide (H2O2)
catabolism (Liu et al., 2019). Both ROS and lipids are important
mediators in cellular signaling in immune cells (Di Cara, 2020; Di
Cara et al., 2017; 2019). H2O2 is a permeable and diffusible molecule
involved in inter- and intracellular signaling during host defense
(Bedard and Krause, 2007; Blander and Sander, 2012).Wemeasured
the cellular amount of H2O2 in Pex2−/− and WT BMMCs. At rest,
BMMCs lacking peroxisome function exhibited similar amounts of
H2O2 (Figure 3A) as WT BMMCs.

Different studies have shown that themetabolism of fatty acids
(FAs) is a major source of biological lipids that form cell
membranes and regulate inflammatory functions (Dowds
et al., 2014; Hubler and Kennedy, 2016; Nath et al., 2022;
O’Neill et al., 2016; Puertollano et al., 2001; Sadik and Luster,
2012). Peroxisomes contribute to the homeostasis of FAs in the

cell (Wanders and Waterham, 2006; Lodhi and Semenkovich,
2014) and we probed whether free fatty acids (FFAs) are altered in
MCs in absence of peroxisomes, affecting cytokine release. We
measured cellular FFAs and observed a significant accumulation
of FFAs in Pex2−/− BMMCs compared to WT BMMCs, at rest
(Figure 3B). Interestingly, we observed that IgE stimulation
triggers a significant increase of FFAs in WT BMMCs while
the level remained unchanged in IgE stimulated Pex2−/−

(Figure 3B). These results indicated that IgE-mediated
stimulation triggers an increase in cellular FFAs in MCs while
lack of functional peroxisomes affects FFA metabolism and
turnover at rest and during IgE-mediated activation.

To explore the link between FFAs and MCs activation, we used
Niacin a vitamin B3 shown to reduce FFAs in plasma, macrophages
and adipocytes by inducing anti-lipolytic effects (Tunaru et al., 2003;
Nath et al., 2022).HumanMCshave been shown to respond to niacin
treatment by prostaglandin D2 (PGD2) production (Papaliodis et al.,
2008). We hypothesised that the accumulation of FFAs in WT
BMMCs was hindering cytokine release under IgE-mediated
stimulation conditions. To test this hypothesis, we treated Pex2−/−

BMMCs with niacin for 48 h to reduce FFAs (Figure 3B) and then
we stimulated the cells. Treatments with niacin reduced FFAs in
Pex2−/− BMMCs at rest to the amount observed in WT. Moreover,
after IgE stimulation, niacin treatment recapitulated the increase
FFAs observed in IgE stimulated WT BMMC (Figure 3B).
Intriguingly, the amounts of released IL-6 and IL-13 after IgE-
mediated activation was rescued to WT levels in Pex2−/− BMMCs
upon 48 h treatment with niacin (Figures 3C,D). This result provides
a link between the cellular FFAs milieu, regulated by peroxisomes,
and cytokine release by MCs.

FIGURE 2 | Absence of peroxisome leads to decreased MCs cytokine release upon TLRs and IgE-mediated activation: WT and Pex2−/− BMMCs were treated
with TLRs agonist or TNP-BSA for 24 h and cytokines amounts were measured by ELISA. (A) IL-6, (B) IL-13 and (C) TNF-α production after TLR2 agonist Pam3CSK4,
TLR4 agonist LPS and calcium ionophore A23187 treatments. (D–F) Same readouts were measured after IgE crosslinking with TNP-BSA treatment for 24 h. The media
columns in each graph represent the baseline level detected for each cytokine. The graphs represent the average of three independent experiments ±SEM.
Statistical analyses were performed using a non-parametric t-test comparing between Pex2−/− and WT BMMCs. *p < 0.05, **p < 0.001, ns: not significant.
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We affected cellular FFAs by treatment with thioridazine, a
small molecule that causes accumulation of FFAs (Van den
Branden and Roels, 1985; Shi et al., 2012). Similar to Pex2−/−

BMMCs, thioridazine-treated WT BMMCs present high amount
of cellular FFAs. Upon IgE stimulation, thioridazine-treated WT
BMMCs secreted lower amount of IL-6 (Figure 3E) and IL-13
(Figure 3F) compared to untreated WT BMMCs. Of note, all the
treatments used to stimulate MCs and/or to manipulate cellular
FFAs did not affect cell viability (Supplementary Figure S2D).

These results indicated that peroxisomal control of cellular
FFAs is required in MCs to respond to and participate in
inflammatory signaling cascades (Figure 4).

DISCUSSION

Peroxisomes are ubiquitous organelles with a central role in lipid
metabolism and ROS production and scavenging (Schrader and
Fahimi, 2006). Peroxisomes have been recognized as organelles of
immunity with central immunometabolic and signaling functions to
regulate immune response to pathogens (Sychev et al., 2017; Xu
et al., 2017; Cook et al., 2019; Merkling et al., 2019). We have
previously shown the central role of peroxisome in macrophage-
mediated host defense (Di Cara et al., 2017; Nath et al., 2022). The
present study aimed to define the role of peroxisome metabolism in
the context of TLR and IgE-mediated activation of MCs. In the

FIGURE 3 |Defects in peroxisomal fatty acid metabolism affects cytokines release in MCs: (A)WT and Pex2−/−BMMCs pellets were assessed for the level of H2O2
and (B) free fatty acids at baseline and after 24 h IgEmediated activation with TNP-BSA inWT, Pex2−/− and niacin-treated Pex2−/−BMMCs. (C,D)Concentrations of IL-
6 and IL-13 were assessed after 48 h of niacin treatment followed by 24 h IgE or A23 activation. (E) Free fatty acids amountsmeasured inWTBMMC at baseline and after
24 h of treatment with thioridazine. (F–G) Effect of free fatty acid metabolism inhibition on IgE-mediated IL-6 and IL-13 release was assessed in C57BL/6 BMMCs.
The media column in graphs C-G represent the baseline level detected for each cytokine. The graphs represent the average of three independent experiments ±SEM.
Statistical analysis was performed using a non-parametric t-test comparing between Pex2−/− and WT BMMCs. **p < 0.001, ***p < 0.0001, ****p < 0.00001, ns: not
significant.
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immune compartment, peroxisome-derived lipids have been shown
to be involved in the development, survival and functions ofmultiple
innate and adaptive immune effector cells (Brutkiewicz and Dent,
2012; Facciotti et al., 2012; Di Cara, 2020).

Lipids are important mediators of mast cell immune functions
(Nakamura et al., 1991; Austen, 2005; Dichlberger et al., 2013).
However, the role of peroxisomes in regulating MCs development
and activation is unknown. Here we determined that lack of
functional peroxisomes in MCs did not alter their maturation,
morphology, or granulation. We report that an increase in
peroxisome number occurs in MCs upon IgE-mediated activation,
indicating the involvement of peroxisomes or peroxisome
metabolism in mast cell responses. Peroxisomes have been shown
to mobilize and to metabolically support activation during viral
infection (Cook et al., 2019) as well as phagocytosis by
macrophages (Eguchi et al., 1979; Di Cara et al., 2017). While the
number of peroxisomes are increased during IgE-mediated
activation, MC degranulation remained unchanged in absence of
peroxisomes, suggesting that peroxisomes might support other mast
cell-specific responses to IgE stimulation but not the degranulation.

Interestingly, in our study, an absence of functional
peroxisomes in MCs led to a significant decrease in TLR2 and
TLR4-mediated IL-6, IL-13 and TNF cytokine production
compared to WT MCs. In potential contrast, Vijayan et al.
showed that peroxisome induction with 4-phenyl butyric acid
in macrophages dampened their IL-6, IL-12 and TNF production
in response to TLR4-mediated activation, suggesting an anti-

inflammatory role for peroxisomes in these cells (Vijayan et al.,
2017). On the other hand, Nath et al., reported a deficiency in IL-
6, IL-1β, and TNF secretion in response to TLR1/2 and TLR4-
mediated activation in Pex2−/− macrophages. When stimulated
with IgE/antigen MCs exhibited a decrease in IL-6, IL-13, and
TNF release supporting the hypothesis that peroxisomes might
have pro or anti-inflammatory functions in different myeloid
cells. Of note, peroxisome dysfunction also impacted cytokine
release following calcium ionophore stimulation but to a lesser
extent. All together our results indicated a stimuli-dependent role
of peroxisomes in MC activation.

Peroxisomes main metabolic functions include β-oxidation of
very long chain fatty acids andmetabolism of ROS.We previously
showed that lack of functional peroxisomes affects cellular H2O2-
mediated signaling that controls uptake of pathogens by
phagocytosis and activation of NF-κB (Di Cara et al., 2017).
While ROS catabolism was unaffected in MCs which lacked
functional peroxisomes, as H2O2 amounts were unchanged,
cellular amounts of FFAs were altered in the absence of
peroxisomes under both unstimulated and stimulated
conditions. Upon activation, changes in lipid composition are
expected in immune cells (Sadik and Luster, 2012; Lodhi et al.,
2015) as lipids are crucial mediators for cell signaling as well as
regulation of inflammation (Sadik and Luster, 2012). Wild-type
MCs exhibited an increased FFAs level after IgE-mediated
activation while this increase was not observed in the absence
of peroxisomes, highlighting the importance of peroxisomes in

FIGURE 4 | Schematic summary of the finding from the study.
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lipid dynamics in MCs. These observations indicate an excess of
lipids in the absence of functional peroxisomes in MCs.
Remarkably, when peroxisome deficient MCs were treated,
prior to activation, with niacin, a FFAs scavenger (Papaliodis
et al., 2008), their cytokine release function was restored,
indicating a restored FFAs turnover with the treatment.
Furthermore, we demonstrated that peroxisome metabolism
has a role in regulating FFAs cellular amounts observed
during IgE activation of MCs. This FFAs regulation appeared
a key mechanism of peroxisome activity in MCs. In fact,
treatment of mast cells with thioridazine, a small molecule
that triggers accumulation of cellular FFAs, recapitulated the
phenotype observed in Pex2−/− cells. The roles of peroxisomal
FFAs homeostasis have not been extensively studied in immune
cells, nevertheless, a few studies showed that thioridazine
treatment decreased TLR mediated activation in macrophages
(Baig et al., 2018; Ganguli et al., 2019) and in T cells reducing
in vitromurine Treg cell polarization while no effects were found
on Th1 or Th17 cells (Moreno-Fernandez et al., 2018).

MCs are critical, tissue-resident sentinel cells with a wide
range of impacts on innate immunity and the mobilisation of
effective acquired immune responses to infection, as well as
impacts on cancer development and anti-cancer immunity.
They are rich at sites that interface with the external
environment such as skin and mucosae and also elevated
around many types of solid tumours. They have been
implicated in effective local mobilisation of immune
responses to a number of parasitic, bacterial, viral and
fungal challenges, in some cases, these include the
generation of ROS, as well as degranulation or selective
cytokine and chemokine production. These studies suggest
that many aspects of such sentinel functions against infection,
such as the production of pro-inflammatory cytokines might
be modulated by peroxisomal activity. Mast cell responses are
known to be modulated by lipid mediators, endocannabinoids
and FFAs (Abdel-Majid and Marshall, 2004; Hagemann et al.,
2019). The current study showed the importance of
peroxisome-mediated lipid metabolism in MCs and
indicates that proper regulation of FFAs modulates MCs
activation and cytokine production. Our work and recent
studies (Eguchi et al., 1979; Singh et al., 2004; Di Cara
et al., 2017, 2019; Vijayan et al., 2017; Nath et al., 2022)
revealing peroxisome involvement in immune processes,
provide a new avenue for therapeutic targeting. Such
interventions, focused on MCs, may allow local modulation
of immune and inflammatory events in specific mast cell-rich
tissues such as the skin, airways or tumour
microenvironment. The selective nature of the impact of
peroxisomes on mast cell function may suggest new
pharmacological approaches to modify cytokine
production, such as that observed in chronic inflammatory
sites without limiting the acute degranulation events
necessary for rapid recruitment of immune effector cells
and dendritic cell mobilisation at the very earliest stages of
infection. The role of peroxisomes in MCs in regulating
allergic disease remains unclear, however the impact of
peroxisome defects on IL-13 production may also suggest

that such organelle function could be targeted in the context
of chronic allergic inflammation.
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